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Learming CQjecuives

¢ Understand the Gear Nomenclatures

¢ Use the Autodesk Inventor Design
Accelerator

¢ Use the Spur Gear Component
Generator

¢ Use the Autodesk Content Center
Libraries




Introduction to Gears

A gear isarotating machine part having cut teeth, which mesh with another toothed part in order
to transmit mechanical motion and power. Gears are very versatile machine elements; they range
in size and use from tiny gearsin watchesto large driving gears in punch presses. Geared devices
can be used to change the speed, torque, and direction of a power source. The most common
situation is for agear to mesh with another gear having parallel shaft axes; however a gear can
also mesh with another toothed part in away to produce motion in anonparallel axis direction.
The more commonly used types of gearsinclude the Spur Gear, the Bevel Gear, the Helical
Gear, the Worm Gear and the Rack and Pinion.
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Two or more gears working in tandem are called agear train and can produce a
mechanica advantage through a designed gear ratio. For gears to function properly, they
must fulfill the following basic requirements: (1) Transmit motion smoothly and
efficiently; (2) Maintain fixed angular relationships between members; (3) Must be
interchangeable with other gears having the same tooth size.



Spur Gear Nomenclatures

_ Dedendum  Addendum
Working Depth
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Clearance

Pitch Dia.
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Root Dia.
QOutside Dia.

Outside diameter (Addendum diameter)
Diameter of gear blank, measured prior to cutting the teeth.

Root diameter
Diameter of the gear, measured across the bottom of the teeth.

Pitch diameter
Diameter of the pitch circle; the standard pitch diameter is a basic dimension at which the
thread tooth and the thread space are equal. The circular tooth thickness, pressure angle
and helix angles are al defined at the pitch circle.

Addendum
The top portion of the gear tooth; it is measured from the pitch circle to the outermost
point of the tooth.

Dedendum
The bottom portion of the gear tooth; it is measured from the root circle to the pitch
circle.

Clearance
Distance between the root circle of agear and the addendum circle of its mate.

Working depth
Depth of engagement of two gears, that is, the sum of their operating addendums.

Whole depth
The distance from the top of the tooth to the root; it is equal to addendum plus dedendum
or to working depth plus clearance.



Circular Pitch
Circular pitch isthe distance measured aong the pitch circle, from a point on one tooth to
the corresponding point on the adjacent tooth.
Circular Pitch = Pitch diameter / No. of teeth

Pitch, Diametral Pitch
Diametral pitch of agear is an expression of tooth size. It is the number of teeth per inch
of pitch diameter. Thus, a gear with a 2-in. pitch diameter and 40 teeth is a 20-pitch gear.
Any two gears having the same pitch will operate together, provided they are based on
the same gear system.
Diametral Pitch = No. of teeth / Pitch diameter = 40/2 = 20-Pitch

Module
A scaling factor used in metric gears with unitsin millimeters whose effect is to enlarge
the gear tooth size as the module increases and reduce the size as the modul e decreases.
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Gear: Thelarger of two interacting gears or agear on its own.
Pinion: The smaller of two interacting gears.
Pitch point: Point where the line of action crosses aline joining the two gear axes.

Lineof action, pressureline
Line of action isthe line along which the force between two meshing gear teeth is
directed. In genera, the line of action changes from moment to moment during the period
of engagement of a pair of teeth. For involute gears, however, the tooth-to-tooth force is
always directed along the same line.

Pressureangle
The angle formed between the direction of the teeth exerting force on each other, and the
common tangent line of the two pitch circles of the two gears. For involute gears, the
teeth always exert force along the line of action, which, for involute gears, is a straight
line; and thus, for involute gears, the pressure angle is constant.



Starting Autodesk Inventor

1. Select the Autodesk Inventor option on the Sart menu or select the Autodesk
Inventor icon on the desktop to start Autodesk Inventor. The Autodesk Inventor main
window will appear on the screen.

2. Select the New File icon with asingle click of the |eft-
mouse-button in the Launch toolbar as shown.

iects  Open
Mew (Ctri+ M) Samples

Launch

3. Select the Metric tab and in the Template list, then select Standard(mm).iam
(Standard Inventor Assembly Model template file).

4 . Templates

; ¥ Part— Create 2D and 3D objects
English

[l Metric '

e | (1) () (@ (&
Sheet Sheet Standard Standard
Metal Metal  (DIM}Lipt (mm}ipt
(DIM}.ipt (rmm).ipt

¥ Assembly — Assemble 2D and 3D components

Hh b B B B &

Mold Mold Standard Standard Weld . Weldment
Design  Design  (DIM).iam I:mrr{/\l?am {EAN?IE_” (BSI).iam
e i L | CifUsers/Public/Document

4. Click on the Create button in the New File dialog box to accept the selected settings and
start a new assembly model.
M E,I - Inthe browser window, Assembly1 is displayed with a set of
T | % AsemblyView v dfi WOrk planes, work axes and awork point. In most aspects, the usage
~ of work planes, work axes and work point is very similar to that of

— <2+ Center Point

% Assembhyl m

B Relationchips ﬂ the Inventor Part Modeler.

Representations ;

=+ [ Origin m Notice in the Ribbon toolbar panels, several component options are
— [ vz Plane m available, such as Place Component, Create Component and
B -“_2 Pl ~ Place from Content Center. Asthe namesimply, we can use parts
B 212';”& m that have been created or create new parts within the Inventor
B ij“m . Assembly Modeler.
— [z Axis m




The Inventor Spur Gear Generator

In this section, we will illustrate the procedures to create gears with the Spur Gear component
generator. Note that the nylon gears in the Tamiya Tiger kit are specifically designed for the
Tamiya kits, and therefore the tooth profiles do not match with the gear profiles generated using
the Inventor Design Accelerator.

E Bearing
[ V-Belts ~

1. In the Design tab of the Ribbon toolbar area, select the Spur
Gear command by left-clicking theicon.

.l AW Spur Gear

”Des'ign Accelerstor .

2. Click OK to savethe current

@ =% You must save the assembly document befare creating a Design assembl Yy
¥ Accelerator compenent.
Do you want to save the assembly?
l 0K M l Cancel
File name: | SpurGears iam 3. Enter SpurGears as the assembly model
name.

Save as type: [Mudes}q Inventor Assemblies {~iam)

5. Click on the Calculation tab to set the associated
Method of Strength power rating of the system.

|150 6336: 1995

Spur Gears Component Generator

A Desig_rﬂ J5 Calculation

Method of Strength Calculation
|Bach (simple design),

6. Choose Bach (simple design) as the method of
strength calculation.

Loads




7. In the Loads section, set the variables using the following values. Power to 0.001 KW,
Speed to 500 rpm and Efficiency to 0.90 as shown in the figure.

Spur Gears Component Generator

&f Design f{} Calculation

Method of Strength Caloulation
[Each {simple design) -
Loads

Gear 1 Gear 2
Power P 0.001kw B 0,001 kW
Speed n  500.00 rpm b 142,86 rpm
Torgue T 0.019Nm b 0060 N m
Efficiency n 050l b
Material Values Fgﬁiciency (m) = 0.980 ul
Gear 1 [ [User material !
Gear 2 [ [user material
Allowable Bending Stress Tan 105.0 MPa b 105.0MPa b

Spur Gears Component Generator

. _ 8. Click on the Design tab to switch back to adjust
D & calcul
&: :]Sr:}in B baatolen the settings of the related gears.
am
Design Guide

[Mudule 9. Set the Design Guide to use Module as shown.

al» 10. Click on the [>>] button to show the additional settings.

11. Set the Input Typeto Number of Teeth and Sze Type to Module and Reaching
Center Distanceto Teeth Correction. Also set the Unit Tooth Szesto the values as

shown.

Input Type Size Type Reaching Center Distance
(") Gear Ratio @ Module @ Teeth Correction

(@ Mumber of Teeth () DiametralPitch (71 Helix Angle

Unit Tooth Sizes

Gear 1 [MGear 2

PR L s o= 1.0000ul ~  1,0000ul -

Clearance o= 0.2000ul ~ 0.2000ul -

Foot Fillet r® 0.2000ul ~  (0.2000ul -




12. Set the Design Guide to Module, Center Distanceto 13.5 mm and Pressure Angle
t0 22.5 degrees. Set the gear option to Component and enter 12 for the Number of
Teeth of Gear 1 and 42 for the Number of Teeth of Gear 2. Also set the Facewidth to 5
mm and Unit Correction to 0.1.

Spur Gears Eompunent Generator =
e e
ﬁ Desian | f& Calculation = d =

Common #
Design Guide Pressure Angle Helix Angle
[ Moduie | 22.5000deg v 0.0000 deg b
Desired Gear Ratio Unit Corrections Guide

3.5000 ul = | [l internal [L.Iser ']
Module Center Distance Total Unit Correction

T S o0 7 [Goed ;
Gearl Gear2

Companent v] Cylindrical Face Eoppoocal v] Cylindrical Face
Mumber of Teeth - Number of Teeth

174 - fj Start plane 74l = ‘Eﬁ Start plane
Facewidth Unit Correction Facewidth Unit Correction

5,000 mm ko 0,100ul ¢ 5,000 ram ko -0,2000 ul }

[ Calcujate ][ OK 13. Click Calculation to initiate the necessary calculations to

determine the gear profiles.

[Initiates calculationi
1@ Teeth Correctid

2. 14. Theresults of the calculations are listed in the dialog box
below, click on the small down arrow to display the dialog box.

15. In this case, Inventor indicated that the gears will need to
be adjusted for proper operation.
Facewidih Unit Carrecton Facewidth Unit Carrechon

5,000 mm Fo0,100 ul 3 5,000 mm o -0,10000ul ¥

12:15:01 AM Design: Gear 1: The Unit Correction {x) is less than the Unit Correction without Undercut I:xp)
12:15:01 AM Design: Mumbers of teeth are commensurable - shots of the same teeth are taken relatively regularly
12:15;01 AM Calculation: Calculation indicates design compliance!

Caiculate | | DKI,\J[ Cancel ]

Input Type Size Type Reaching Center Distance

16. Click OK to proceed with placing the gears in the assembly model.



17. Click OK to accept the default naming of the files for the new gears.

File Naming &
[tem Display name File name
Subassembly Spur Gears Ci\Inventor-DataMechanical-Tiger\SpurGears\Design Accelerator\Spur Ge...
Gear Spur Gearl Ci\Inventor-DataMechanical-Tiger\SpurGears \Design Accelerator\Spur Ge...
Gear Spur Gear2 Ci\Inventor-DataMechanical-Tiger\SpurGears\Design Accelerator\Spur Ge...
[7] Always prompt for flename ’ QK !}J [ Cancel ]

18. Place the gearsin the assembly model by clicking in an empty location inside the
graphics window.

e The Autodesk Inventor Design Accelerator provides a convenient way to create a gear
set. Note the creation of true gear tooth profiles can be very time consuming by

traditional methods. The created gears can aso be edited and modified just like aregular
Inventor part.



Using the Content Center

1. In the Assemble panel select the Place from Content Center
command by left-clicking the icon. Also set thefilters option
to 1ISO.

g

Create

| Place from Content Center
View I Tools | Help
— (€] Search - iﬁl
[} -|| Place from Vault Favorites r

= Filters »
Q Place from Cgntent Center i@ ;
i - Histaon BSI
= 2 - GB
I, 2
&P | Place Importd Flace from Co i Ei« AutoDrop
i GOST

Language Setting H [ e

2. Sdlect the Fasteners category and then
Refresh Content... 15 h?

Pins as shown.

[~ Cable & Harness (-4 Cable &Harness
(- % - fm Fasteners
£ Fea b - Bdts
E Mold @ MNuts
[#-/&) Other Parts -
5. {m ts
- Washers
|| G-Lg) Features

B Cable & Harness

[=-fmn Fasteners

- Bolts

@ Muts

=D Ping

. @2 Clevis Pins
[#-@= Cotter Pins

3. Choose Cylindrical under Pins as shown in the figure.

= S e R —

DIM EM ISC 87358  DIM EN ISO 8745 DIM EM ISO 8750

———— - ;
4. Select 1ISO 8734 as shown in the e = %

figure. IS0 2338 C - 150 8733 150 8734
withdrawn




150 8734 By 6. Set the designation diameter to 3 mm.

Select m
ieeioeesr  Tmem . 7. Set the nominal length to 30 mm.
B "
15 10 . .
a— N u . 8. Switch ON the As Custom option as
L—ﬂ 12 shown.
I 16 FF ) ) -
% 4 ~ 9.Clickonthe Table View tabto view a
e FR—— more detailed listing of the available pins.
2
508734
© As Custom [Tl Use iMate Table Igaw
) As Smkard
Display: |+
[oc ][ cancel | [ oy [ All Columns

> Notethe selected pinis
highlighted in the list.

11. In the Save As dialog box, enter Shaft-3x80.ipt as the model filename as shown.

Fie name Shaft- 380 ipt .
Save a3 hype :mmfkrn} ':

12. Click Save to save the model.

Note that by saving the part as a custom file, thiswill allow the adjustment of the length of
the shaft.



13. Inside the graphics window, right-click once to bring up the option menu and select OK
to end the Place Component command.

14. Inside the browser window, right-click once on the
Shaft-3x80 part to bring up the option menu and
select Edit to modify the part.

.

Inspect _ Tools 15. Click on the Manage tab to switch to the Manage
: toolbar.

]

el

16. Click the Parameters icon to bring up the Parameters
dialog box.

Parameters Styles Editor

—| Parameters

[ [ [ i, ik
| - 17. Edit the value of the NLG
St :[‘g e ;Df"m r ;” (Nominal Length) variableto
mm mm 4
] 80 mm as shown.
| {PHH mm | 0.gm
:| FAWI deg 15| NLG is consumed by d2 }_ 15,
i DT mrm DHH ng

T—— 18. Click Done to accept the
adjustment and exit the parameters dialog box.

19. Click Save to save the changes to the model.

20. In the Ribbon toolbar area, click Return to end the editing of the
Shaft Model and return to the assembly model.

Ee=t
Return (Ctrl+Enter)
F~RemT




	

